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1. Allmänt 
GrayWolf systemet består av en handenhet 

”AdvancedSense Pro” med proben ”DirectSense II” 

(DSII-8) samt PC programmet WolfSense PC. Proben 

är utrustad med sensorer för temperatur, relativ 

luftfuktighet, ozon (O3), kolmonoxid (CO), 

kvävedioxid (NO2), svavelväte/vätesulfid (H2S) och 

ammoniak (NH3). Det ena instrumentet har även en 

syre- (O2) sensor och det andra har en kvävemonoxid-

(NO) sensor. (Se tabellen nedan.) 

 

För att tanka ur loggade data behöver man installera program från medföljande 

USB minne och ansluta instrumentet till en USB port. Det drivs med inbyggda 

laddningsbara batterier eller nätdrift. Test gav batteridrifttid på över 16 h. 

 

Instrumentet har många möjligheter och appar, liksom en smart phone. Denna 

FMI tar upp direktavläsning och loggning. För avancerade funktioner och andra 

möjligheter så hänvisas till originalmanualerna som finns med på USB minnet.  

 

 O3 CO NO2 H2S NH3 O2** NO** 

Mätområde 

(ppm) 

0 - 1 0 - 750 0 - 20 0 - 50 0 - 100 0 - 25 % 0 - 140 

Upplösning 

(ppm) 

0,01 0,1 0,01 0,01 0,1 0,1 % 0,1 

LOD (ppm) 0,02 < 0,3 0,02 0,03 < 1  0,2 

T90 (s) < 60 < 25 < 50 < 30 < 60 < 15 < 45 

Sensor drift 10 % / 

halvår 

5 % / år 10 % / år 2% / år 5 % / 

halvår 

 < 5 % / år 

NGV (ppm) 0,1 20* 0,5* 5 20  2 

KGV (ppm) 0,3 100* 1* 10 50  - 

 

LOD är nedre detektionsgräns. T90 är reaktionstiden för sensorn, den tid det tar 

innan sensorns utslag är 90 % av aktuell nivå. 

* För underjord- eller tunnelarbete träder dessa i kraft den 21 augusti 2023, andra 

gränsvärden gäller fram till dess.  

** O2 på ett instrument och NO på det andra instrumentet. 

  

Handenhet           Prob 
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 Mätområde Noggrannhet 

Temperatur -15 till + 70 °C ± 0,3 °C 

Relativ luftfuktighet 0 till 100 % RH 
± 2 % RH upp till 80 % 

± 3 % RH över 80 % 

Driftsområde: -10 till +50 °C, 0 till 100 % RH men ej kondenserande.  

Minnet i handenheten är på 32 GB. 
 

Detekteras inte proben när både handenheten och proben startas samtidigt kan 

man antingen starta om båda enheterna igen alternativt försöka detektera proben 

manuellt - detta görs genom att klicka på menyn Probe och sedan Scan for 

Additional Probes.  

 

Används ej kabelanslutning, kontrollera att blåtand är aktiv, detta görs via menyn 

File -> Power Options -> Radio Power (Wi-Fi/Bluetooth) - där ska både 

Enable Bluetooth och Radio Power On vara förbockat (vid ändring kan 

instrumentet behöva startas om). 

 

1.1. Korskänslighet 
Sensorerna i GrayWolf’en är elektrokemiska och det är vanligt att elektrokemiska 

celler reagerar på fler ämnen än det som de är konstruerade för, vilket kan 

påverka mätvärdet, detta benämns korskänslighet. I tabellen nedan har vi valt ut 

de större korskänsligheterna (> 10 %) och ett par andra. 

 

OBS! Tänk på tecknet för korskänsligheten, om det t ex är 10 ppm H2S och 4 

ppm NO2 i luften, visar instrumentet att det är 0 ppm NO2.  
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Ett urval av korskänslighet för respektive sensor 

Korskänslighet NH3 Korskänslighet CO Korskänslighet H2S 

H2S 120 % NO < 5 % SO2 < 10 % 

SO2 - 30 % NO2 < 0,1 % NO < 2 % 

NO2 - 150 % H2 < 60 % NO2 < - 30 % 

  C2H4 25 % CL2 < - 25 % 
      

Korskänslighet NO2 Korskänslighet O3 Korskänslighet NO 

SO2 < - 2,5 % Cl2 120 % NO2 < 5 % 

Cl2 100 % ClO2 150 % Cl2 < 15 % 

H2S - 40 % N2H4 - 100 % H2S < 30 % 

O3 167 % H2S - 8 % CO < 0,1 % 

  NO2 60 %   
      

Korskänslighet O2     

CO2 10 %*     
      

* Dvs om det är 20,9 % O2 och 10 000 ppm (1 %) CO2, så visar instrumentet 21 % O2 (20,9 

+ 1*10%). 

Siffrorna i tabellen avser om det finns ett störande ämne närvarande, vad det ger 

för utslag för aktuell sensor.  

T ex om det är 10 ppm H2S under mätningen, så visas det som: 

12 ppm på ammoniak sensorn 

- 4 ppm på kvävedioxid sensorn 

- 0,8 ppm på ozon sensorn 

 

Överkurs:  
Tittar man enbart på ozon- och kvävedioxidvärdena, kan man inte avgöra vilket 

av ämnena det är. Tittar man på värdena även för de andra ämnena, så kan man 

via korskänsligheterna avgöra om det är NO2 eller O3. 

Tillverkaren har lagrat information om de kända korskänsligheter i instrumentet. 

Informationen hittas via menyn Probe -> Sensor Tips -> på första raden, välj 

sensor utifrån vilket ämne den är konstruerad för -> vänta någon sekund -> på 

andra raden, välj Sensor Specifications for -> rulla ner till CROSS 

SENSITIVITY. Det är första kapitlet med CROSS SENSITIVITY som är 

aktuellt vid användning av Instrumentpoolens instrument. Vissa sensorer har fler 

kapitel med rubriken CROSS SENSITIVITY men det är för andra varianter av 

sensorerna.  

 

Det är svårt att tolka korskänsligheten som visas i instrumentet. 
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2. Snabbguide 
1. Starta upp båda enheterna. 

2. Invänta att parametrar och mätvärden visas med svart text. 

Instrumentet är nu i direktvisningsläget. 

3. För att spara enstaka värden, välj var mätdata ska sparas. 

4. Enstaka mätvärden: Log -> Snap Shot Log. 

5. Loggning med tidsintervall: Log -> Start Trend Log. 

Stoppa med Stop ikonen alternativt Log -> Stop Trend Log. 

6. Normal avstängning genom att hålla in respektive På/Av knapp 3 sekunder. 

 

3. Uppstart - avstängning 
Starta upp handenheten samt proben genom att trycka en gång på respektive 

På/Av knapp. Dioden på proben blinkar med olika färger under uppstarts-

sekvensen. När proben är redo blinkar dess diod blått. Vid kabelanslutning mellan 

prob och handenhet, avvaktiveras blåtand. Blinkar proben växelvis blått/grönt och 

rött, indikeras låg batterinivå. Det kan ta en minut innan handenheten har kopplat 

upp proben. Första minuterna efter uppstart reagerar instrumentet långsamt på 

kommandon. 

 

Låga nivåer: När ni ska mäta låga nivåer (i storleksordningen av LOD), bortse 

från mätresultaten från första halvtimmen. Vid våra tester har vi till exempel sett 

att svavelväte började vid 0,1 ppm när det inte borde finnas något svavelväte, 

men efter en halvtimme hade mätresultatet gått ner till 0 ppm, ammoniak började 

vid 0,2 ppm. 

 

Normal avstängning görs genom att hålla in På/Av knappen 3 sekunder på 

respektive enhet. På proben lyser dioden rött i 2 sekunder och den stängs sedan 

av. När handenheten stängs av normalt, så stoppas eventuell pågående loggning. 

 

Tvingad avstängning görs genom att hålla in På/Av knappen minst 12 sekunder 

på respektive enhet. Enheten stängs av direkt med risk att förlora data som inte 

hunnit sparas. 

 

4. Direktvisande 
Instrumentet startar alltid upp i läget direktvisande (Live 

Screen). 

 

Starta båda enheterna och invänta att parametrarna och 

mätvärdena visas med svarta tecken.  



Region Örebro län   FÄLTMÄTINSTRUKTION     5(13) 
Arbets- och miljömedicin, laboratorieenheten, USÖ 
 

Dok beteckning: FMI 09:113 Utgåva nr: 5 Utfärdad av: AJ  26 juni 2020 

  Ändrad av: Anders Johansson 5 mars 2024 

Godkänd av/datum: Lab. chef Ina Lindell  5 mars 2024 Reviderad av: Anders Johansson 25 april 2022 
 

GRAYWOLF 
 

Innan tecknen blir svarta, syns anledningen i statusfältet, det kan bland annat vara 

uppvärmning av sensorerna. 

För att komma tillbaka till direktvisande läget, klicka på Live-ikonen  

alternativt välj Live Readings från View menyn.  

 

När man klickat på en parameter, kan man byta enhet för den eller avaktivera 

den. För att aktivera en parameter igen, välj Select Parameters under View 

menyn och bocka för den som ska aktiveras.  

 

5. Loggning 
Kapitlet direktvisande gäller även vid loggning. 

 

Man kan välja att spara enstaka mätningar (Shot Log) eller att logga med 

tidsintervall (Trend Log).  

 

Under menyn Log -> Log Options väljer man:  

1) Om loggning med tidsintervall ska vara ögonblickliga  

värden eller medelvärde över loggintervallet.  

2) Om enstaka mätningar ska vara ögonblickliga värden,  

5, 10 eller 15 sekunders medelvärde. 

3) Om filen redan existerar - alltid fortsätta fylla på den  

eller om man ska få frågan. Gör man flera enstaka  

mätningar efter varandra, så är det bara första gången  

man får frågan. 

4) Klicka på Advanced … för att välja om Log knappen  

på proben ska vara för enstaka mätningar eller  

utan funktion. 

 

I instrumentets filstruktur kallas mapparna för Site och 

filerna för Location. Som filikon används ett varghuvud,  

det är ljusgrått när filen är tom och mörkare när den 

innehåller mätdata.  

Nya mappar och filer skapas från menyn Log -> Locations 

alternativt Trend loggning. Klickar man på den gröna 

ikonen Log, så kan man välja Snap eller Trend loggning 

samt var mätdata ska sparas. 

 

Enstaka mätningar sparas i den fil som är vald (blå- 

markerad) under Locations och startas bland annat från 

menyn Log -> Snap Shot Log. 

1 

2 

3 
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Loggning med tidsintervall startas från: Log -> Start 

Trend Log. Här får man välja var mätdata ska sparas samt 

vilket loggintervall man vill ha. Loggningen stoppas med 

Stop ikonen alternativt Log -> Stop Trend Log. 

 

När man börjar logga till en fil som redan innehåller 

mätdata, får man frågan om man vill ersätta, fylla på eller 

ändra fil. Loggar man flera gånger utan att starta om 

instrumentet, så fylls filen på med mätdata.  

 

Man kan inte ha olika enheter för samma parameter i en 

fil, när man bytt enhet måste välja en ny fil eller att skriva 

över mätdatan. 

 

6. Visa mätdata 
I instrumentet går det att se loggad mätdata både som graf  

och som tabell. 

 

Grafen öppnas genom View -> Graph. Klicka på Select  

under grafen, för att välja vilken fil som ska visas och  

nedanför det kan man välja vilken parameter som visas. 

 

 

 

För att se loggad data som tabell får man klicka på meny ikonen (ej begränsat till 

grafvisningsläget). 

 

 

 -> Apps.  

 

-> Review Logged Data.  

 

Ovanför tabellen står  

filnamnet, klickar man på  

det kan man välja vilken  

fil man vill titta på. 
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7. Övriga funktioner 
Varghuvudet är menyikonen och öppnar en meny 

med ikoner (stängs automatiskt efter några 

sekunder). Raden med ikoner kan bara bläddras 

med högerpilen avvaktar man några sekunder så 

att raden stängs, så börjar det om från början. 

 

Apparna hittas via ikonen med varghuvud och sedan Apps. 

Ordningen på ikonerna ändras efter hur ofta de används. 

Kameran - via kameraikonen så kan man sedan använda kameran på baksidan, 

lampan på baksidan går också att styra från kameraläget. 

 

Instrumentet har många möjligheter och appar, liksom en smart phone. Denna 

FMI tar upp direktavläsning och loggning. För avancerade funktioner och andra 

möjligheter hänvisas till originalmanualerna som finns med på USB minnet.  

 

Det lilla stativet kan användas som 

stöd för antingen handenheten eller 

proben. Skruva in skruven på stativet 

och lås sedan med muttern/brickan. 

Vredet på sidan är låsning av 

kulleden. 

 

 

 

 

8. Batteri/laddning/ström 
 

OBS! Vissa sensorer behöver kontinuerligt lite ström. Tar batteriet i proben slut, 

ladda det före transport eller förvaring. 

 

Båda strömadaptrarna är likadana. Det går bra att mäta med laddarna anslutna. 

 

AC Charge dioden på handenheten lyser rött under laddning och grönt när 

batteriet är fulladdat. Dioden på laddningsdockan lyser grönt när strömmen är 

ansluten och orange när proben är i dockan. (Det stämmer inte med manualen 

som påstår att dioden ska lysa rött under laddning och grönt när batteriet är 

fulladdat.) Blinkar dioden på handenheten rött, så indikerar det ett batterifel. 

Blinkar dioden på proben rött, så indikerar det något fel, se originalmanualen. 
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Batteriikonen på skärmen är grön när batteriet är fulladdat, rött visar att 

batterinivån är låg/kritisk och däremellan är ikonen grå. Klickning på 

batteriikonen visar noggrannare batteristatus samt även batteristatus för proben 

om den är ansluten (via sladd eller blåtand). För proben indikeras låg batterinivå 

genom att dioden blinkar rött växelvis med blått/grönt. 

 

Både handenheten och proben har litiumjonbatteri. Test gav drifttid på 16,5 h, 

med skärmsläckaren aktiv, blåtandsuppkoppling, båda enheterna gick på sitt eget 

batteri och medelvärdesloggning en gång i minuten av alla parametrarna. Mätdata 

från testet var på 44 kB. Tillverkarens uppger att handenheten tar 4 h att ladda 

och har sedan 18 h drifttid proben tar upp till 6 h att ladda.  

 

Proben stängs av efter 8 minuter om det inte finns någon förbindelse med 

handenheten. 

 

Skruven på baksidan av laddningsdockan är om man vill säkra proben i 

laddningsdockan. 

 

9. Koppla ihop prob med handenhet 
Proben ansluts antingen via blåtand eller via kabel. För båda alternativen kan det 

ta en minut innan uppkopplingen är klar.  

 

För att skifta mellan kabel och blåtandsanslutning:  

I handenheten, menyn File -> Power Options -> Radio Power (Wi-

Fi/Bluetooth). 

För blåtandsanslutning ska det vara en bock i både Enable Bluetooth och Radio 

Power On (WiFi/BT). Kabeln ska inte vara ansluten, starta om handenheten och 

proben. 

För kabelanslutning ta bort bocken i Enable Bluetooth. Kabeln ska vara 

ansluten, starta om handenheten och proben. 

 

När proben är redo blinkar den blått. Har det inte upprättats en anslutning inom 

fem minuter, stängs blåtanden av.  

 

Om kontakten mellan handenhet och prob tappas, stäng av båda två och starta 

dem samtidigt. Alternativt kan man försöka detektera proben manuellt – detta 

görs genom att klicka på menyn Probe och sedan Scan for Additional Probes. 

 

Kabeln kan anslutas direkt mellan handenheten och proben.  

Kabeln kan även anslutas mellan handenheten och laddningsdockan med proben.  
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Den svarta änden av kabeln ska anslutas i en av de två högra kontakterna i 

underkant av handenheten och den blå änden av kabeln ska anslutas i proben eller 

dockan.  

 

Man kan mäta med proben i laddningsdockan, både med blåtandsanslutning och 

kabelanslutning. I inget av fallen behöver laddningsdockan ha strömmen ansluten 

om probens batteri är laddat.  

 

10. Manualer och installation i PC 
Manualerna finns på bifogat USB minne i mappen Manuals. Bland manualerna är 

det tre som är aktuella: AdvancedSense PRO (handenheten), DirectSense II 

(proben) och WolfSense PC (datorprogrammet). 

 

Med filen wspc som finns på medföljande USB minne, installerar man 

WolfSense PC. Koden som behövs finns i filen ”Kod wspc filen”. 

 

OBS! Ibland behöver datorn startas om för att det man installerat ska fungera. 

 

Istället för att installera drivrutiner sköts kommunikationen via programmet 

Mobile Device Center. Innan man ansluter instrumentet måste Mobile Device 

Center ha startats upp. Det kan stå som Center för Windows Mobile-enheter 

under startmenyn. 

 

Microsoft stödjer inte längre Mobile Device Center, så det går inte längre att 

ladda ner men det finns på bifogat USB minne i mappen WMDC. 

 

Om instrumentet inte känns igen när det kopplas in får man installera/uppdatera 

Mobile Device Center.  
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För 64 bit operativsystem, installera Mobile Device Center genom att 

dubbelklicka på drvupdate-amd64.exe i WMDC mappen på USB minnet (för 

32 bit operativsystem är det i stället filen drvupdate-x86.exe). 

Starta om datorn. 

Windows 10: om det fortfarande inte kommer fram ett fönster efter start av 

Mobile Device Center, kör filen WMDC Win10.reg som också finns i mappen 

WMDC. När det är klart, starta om datorn igen. 

 

I mappen WMDC finns en pdf fil Tech Note… som ger vägledning till hur man 

kan göra i Windows 10. 

 

Det finns två visningslägen i WolfeSense PC - 

TILE och CLASSIC. Man byter mellan dessa 

under menyn Window och klickar på 

”Display Apps Tile Interface” alternativt 

”Change to Classical Menu View”. 

 

 

11. Överföring av mätdata till PC 
1)  Instrumentet måste vara igång. 

2)  Efter anslutning av USB kabeln kommer fönstret ”Center för Windows 

Mobile-enheter” fram, det behöver ligga kvar i bakgrunden. 

3)  Starta WolfSense PC. 

4)  Enklast är om Toolbar är framme,  

klicka på Transfer. 

Alternativt kan man gå via File –>  

“Transfer from GrayWolf Meter … “  

 

 

 

 

 

 

Ändrar man destination,  

måste man klicka på en annan fil  

än den som är markerad, sedan kan man  

välja den första igen.  

Detta eftersom att Transfer to  

inte uppdateras annars och det är  

Transfer to som styr vart filerna hamnar.  
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Man kan välja mellan att markera en fil och markera flera filer intill varandra, för 

att markera flera filer klicka på den första, håll in Shift och klicka på den sista. 

Det fungerar inte att hålla in Ctrl och klicka på flera filer. 

 

Transfer för över filerna medan Open för över filerna och öppnar sedan dem. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Filstrukturen man har i instrumentet, bevaras när man för över filer till datorn. 

Det vill säga mappar man har i instrumentet skapas i datorn vid överföringen. 

 

12. Exportera data 
Under File, välj “Export to Excel… “ alternativt om Toolbar är framme, klicka 

på Export.  

 

För utförligare information, se FMI 09:117 Bearbetning av mätdatafiler i Excel. 

 

När man öppnar en fil från WolfSense PC i Excel, kan både tid och datum se 

konstigt ut. Det beror på att det blir en annorlunda formatering. Lösningen är att 

markera hela kolumnen och välj önskad formatering. 
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Om en grön triangel återfinns på flera av cellerna indikerar det att Excel uppfattar 

data som text. Detta kan åtgärdas genom att man omvandlar text till kolumner. 

OBS! Omvandla enbart en kolumn i taget.  

 

Klicka i första cellen med data. Håll in Ctrl + Shift och tryck på nerpil, så att 

alla data i den kolumnen blir markerade. Välj menyn Data och sedan Text till 

kolumner då startas Guiden Omvandla text till kolumner. Välj Avgränsade 

fält och ingen avgränsare ska vara vald och klicka sedan på Slutför. Då bör alla 

gröna trianglar i den kolumnen ha försvunnit. 

 

13. Radera mätdata 
Man kan radera mätdata både direkt i instrumentet och via datorn. 

 

I instrumentet välj Log -> Locations. Välj den fil eller mapp som ska tas bort och 

klicka på papperskorgen. Om en fil markeras får man i följande steg välja om 

den ska tömmas (Clear) eller tas bort (Delete). 

 

I datorn öppna Transfer, markera de filer som ska tas bort från instrumentet och 

klicka på Delete. 
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14. Packning i väskan 
Vi har två instrument, väskorna och laddarna ser olika ut. 

 

Först får man lägga i båda laddarna utan 230 V kabel. 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 
230 V kablar 

USB kabel 

Kabel prob - handenhet 

Laddningsdocka 

1 Stativ 

USB minne 


